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Introduction 
An integral part of making documents accessible is in the design and creation process. Every attempt 

should be made to use the inherent structural elements available in the native application whether it is 

word processing, slide presentations, spreadsheet, or desktop publishing software. This resource 

identifies some of the issues and many of the repair tools available to document authors so that they 

can design and create more accessible documents and PDF documents. 

Landscape Architecture 
One of the difficult things to decide is what constitutes and accessible PDF document. This is where we 

begin. There are several things to consider. 

“Compliance” Issues 
The first issue is that of the accessibility full check tool in acrobat Professional. This is a mechanical tool 

and no substitute for a review and “sign-off” from a document author or repair technician. It is a tool 

similar to the Bobby or A-Prompt tools for validating web based content. An accessibility full check can 

point out potential problem areas, but these items might not be. A good example of this is when images 

are used as links. Would a clean full check be providing alt text for the image or ensuring that a link is 

created and given alt text in effect demoting the image itself to a “background” role in the document? 

The second “compliance” issue is getting caught in being “specific adaptive technology compliant.” In 

most cases the baseline for this is a version of the JAWS screen reader. The problem with promoting 

something as “JAWS compliant” is that it negates accessibility for all people with disabilities using tools 

other than that specific version of the screen reader. Not all adaptive technologies have the same 

capabilities when it comes to accessing digital content including PDF. The implication of this approach is 

that everyone reading the tagged PDF  content will have to have exactly that version of Adobe Reader 

and that version of the adaptive technology and, in extreme cases, even settings for both might be 

specified. This removes the “right” of the “end-user” to control how they view and interact with the 

content. It also puts those who don’t use a specific screen reader or who can’t afford to upgrade their 

adaptive technology at an extreme disadvantage. 

A third item to consider is what parts of a document will be required to be tagged. As a person using a 

screen reader, there is nothing worse than having my thought process or comprehension interrupted by 

the identification of decorative elements, header or footer information or sidebar quotes plunked into a 

Tags Tree at the point at which they appear on the page. This is not how we access the content visually, 

yet “purists” believe that all pieces of content should be tagged/identified to the end-user at the point 

at which they appear on the page no matter how intrusive or disruptive they might be to the person 

reading the document.. 

Other issues include ensuring that if a document has multiple languages or a specific language that all 

parts of that document reflect that language. For example, not having a document in French with 

graphics that have English text. Another item to consider is the amount of information contained in a 

figure’s alt text. If adaptive technology has to buffer a lot of information “at once” it could result in a 
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crash of the application or the adaptive technology, or that some of the alt text is not read. This means a 

complex image that takes up an entire page should be given concise Alt Text or broken down into 

smaller figures. 

The majority of the accessibility issues in a document can be identified and repaired or designed more 

effectively in the native application before it gets to the tagging process. 

Picking up the Shovel. 
Before we begin digging ourselves into what might appear to be a bottomless pit…tagging PDF 

documents, we need to look at two things. One is a hierarchy of tasks when working with PDF 

documents and the other is the basics of an accessible PDF document. 

The hierarchy of tasks are the series of questions we mentally go through each time we look at a PDF 

document that needs to be made more accessible. 

1. Is it a scanned document? 

2. Does it have hyperlinks 

3. Does it have form fields? 

Of course this can result in more questions and more tasks. If it is a scanned document, OCR will need to 

be performed on the document. If there are links in the document, they need to be added before the 

document can be tagged. If there are form fields, they need to be added before the document is tagged.  

The basics of a tagged PDF document include: 

1. A defined language for the document or language specific paragraphs. 

2. Tags that are correct. 

3. Logical reading order of content. 

4. Headings that reflect the hierarchy of content. 

5. Bookmarks that correspond to headings. 

6. Alt Text for images and links. 

7. TH Tags for table headers which are the column and row titles.. 

Every attempt to create a logical document structure and reading order in the native application should 

be made. When the document is tagged as PDF, it is these structures that will be used to create the tags. 

Tag…You’re It! 
What are tags and how do they work? 

If we think of Corel WordPerfect or HTML for web pages, we have an idea of what tags are. PDF tags are 

XML based. Tags define the role of content in a document. For example there are heading tags, 

paragraph tags, list tags, figure tags, and table tags. Each of these contributes to the readability and 

structure of a document whether it is tagged PDF or other file formats such as Microsoft Word. 
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Tags have a hierarchy of parents and children. The “Tags” root is the base of the family tree. From there, 

tags can branch out much the same way our folders do on a hard drive. 

 

Figure 1 Tags Tree in Acrobat X. 

Examining the Foundation in Microsoft Word 
One of the most powerful tools document authors have is the document template. This lets document 

authors create specialized formatting and structure based on the type of document required. The use of 

templates lets those working with the template to use the keyboard commands they are familiar with to 

apply the heading styles and doesn’t “corrupt” the inherent styles in the normal application template. 

To create a template in Word 2003, 2007 or 2010: 

1. Open a new document. 

2. Press F12. 

3. Give the file a name – for example Annual Report. 

4. Tab to the files of type list box and choose: 

a. Document Template for Word 2003 which is a DOT format. 

b. Word Template for Word 2007 or 2010 which is a DOTX format. 

5. Move to and activate the OK button. 

The default styles can now be modified without affecting the normal template styles. 

New custom styles can also be added. 
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Make sure that the folder in which the file will be saved was changed to the global Microsoft Template 

folder on your hard drive. 

To use the template: 

 Choose File > New > On my computer and select the template for Word 2003. The keyboard 

command is Alt + F, N and then locate the My Computer category in the pane that has opened. 

 In Word 2007, choose Office Button, New,  which opens a dialog. Press Shift + Tab to move to 

the Navigation area where you will find templates on my computer or My templates. Once the 

dialog opens, use first character navigation to find the template you want. The keyboard 

commands are Alt + F, N to open the Templates dialog. 

 In Word 2010 choose File/Backstage area, New and then press Tab to move into the types of 

templates.  Choose the My Templates category which will open the standard dialog from which 

you can use first character navigation to locate the template you want. The keyboard command 

is Alt + F, N and then Tab into the categories of templates. 

In all versions don’t open the DOT or DOTX file from the recently used documents or you will open the 

template itself. You need to use the File, New combination to use the template. 

Headings and Styles 
It is important to use the inherent structural headings in Word to mark topic changes. This booklet has 

used headings in a proper hierarchical manner. You apply a heading 1 for a top level topic and then a 

heading 2, followed by a heading 3. You don’t apply a heading 1 followed by a heading 3 or 5. The 

headings identify the hierarchy of content. 

To apply a heading style in Word: 

1. Select the text that is to be a heading. Do not select entire paragraphs of text! 

2. Press Ctrl + Alt + number 1 for a heading level 1. 

3. Press Ctrl + Alt + 2 for a heading level 2. 

4. Press Ctrl + Alt + 3 for a heading level 3. 

If you don’t like the default style of the headings, you can modify them using the Styles Pane. This is why 

we created the template….so that each document you create an have the same look and feel and be 

customized for your organizational brand including colours and fonts. 

Alt Text on Images 
Every image in a document that assists understanding of the content should be provided with Alt Text. 

Alt text should be concise and meaningful. Any images used in documents should be supported in 

surrounding content or support surrounding content. Decorative images do not need Alt Text in PDF. 
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To add Alt Text in Word 2003: 

1. Select the image or object: 

2. Press the AppKey. 

3. Choose Format Picture. 

4. Move to the Web tab by pressing Ctrl + Page Up or Page Down. 

5. Add the Alt Text. Note that if you press Enter at this point you will add another line to the Alt 

Text not close the dialog. 

6. Move to and activate the Close button. 

 

Figure 2 Size dialog in Word 2007 showing the Alt Text tab. 

To add Alt text in Word 2007: 

1. Select the image or object: 

2. Press the AppKey. 

3. Choose Size and Position. 

4. Move to the Alt Text tab by pressing Ctrl + Page Up or Page Down. 

5. Add the Alt Text. Note that if you press Enter at this point you will add another line to the Alt 

Text not close the dialog. 

6. Move to and activate the Close button. 
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Figure 3 Alt Text dialog from Word 2007. 

To add Alt text in Word 2010: 

1. Select the image or object: 

2. Press the AppKey. 

3. Choose Format Picture. 

4. Move to the Alt Text category by pressing Tab once and then pressing the End Key. 

5. In Office 2010 you also have the option of adding a Title to the image. Tab into the Alt Text 

options and then Tab to the Title and/or Description of the image. 

6. Add the Title or Alt Text. Note that if you press Enter in the Alt text edit area you will add 

another line to the Alt Text not close the dialog. 

7. Move to and activate the Close button. 

 

Figure 4 Alt text dialog in Word 2010. 



9 
 

By adding Alt Text to Word, PowerPoint, or Excel documents adaptive technology can read this 

information to the end-user in those applications as well as converted tagged PDF. 

Captions for Images 
As of Acrobat 9 and continued into Acrobat 10, there is an oddity when converting Word documents to 

tagged PDF. What happens is that all of the <Figure> Tags get tossed to the top of the Tags Tree. While 

dragging them to their proper place in the Tags Tree doesn’t take much time if the document is five 

pages or less, in larger documents this is time consuming and counterproductive. 

I advocate using captions as part of your workflow so that if the image is blurry or unrecognizable on a 

printed page the person reading the  document can read the caption text. 

Alt Text for Links 
It is important to create contextual links in documents rather than plunking the long URL’s into the 

document in the middle of text. By creating more accessible links the overall accessibility of the 

document is improved. Consider which you would like to try navigating through: 

 

Figure 5 A List of inaccessible links from a Word document using the JAWS screen reader. 

Where would this fourth link take you and what would you expect to find there? Would you listen to the 

entire URL before knowing what the filename is? What if the filename is file-01.html – where would that 

take you? 

Now, look at links created to be more accessible. The person reading this document has a clear idea of 

where they are going and what they can expect if they follow a link. 
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Figure 6 A lists of accessible links from a Word document using the JAWS screen reader. 

If you look closely at this document, a solution is demonstrated if the document will be printed out, or if 

the document author wants to include the URL itself for clarification.  

 

Figure 7 Create Hyperlink dialog. 

To add a link to a Word document: 

1. Select the text you want to act as the text to the link. 

2. Press Ctrl + K. 

3. Either type in or copy and paste the URL into the address edit box. 

a. The “alt text” is shown at the top of the dialog in the “Text to display” edit box. 

4. Tab to the OK button and Press Enter or simply press Enter once you’ve inserted the web 

address. 

Links can be to a URL or another file. If you activate the e-mail address button, links can even have a 

blank e-mail message open when the link is activated. 

Remember not to start links with “Go to…” or “Select this link to…” as it prevents the use of first 

character navigation through the links. “click here” or “here” or “click” aren’t helpful when attempting 

to determine where a link will take you. 

These are the basics of an accessible Word to PDF document. Now let’s look at the trenches! 
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Examining the Foundation in Acrobat 
There are several foundational tools available in Acrobat Professional X that we can use to make repairs 

on what can best be described as “ICKY” documents. The tools identified in this handout are: 

 Language. 

 Tags Tree. 

 Highlight Content. 

 TouchUp Reading Order or TURO tool. There are two ways of working with this, the Order Panel 

and the TURO panel which floats over the document. 

 Find Tag From Selection. 

 Create Tag from Selection. 

 OCR Text Recognition [for scanned documents]. 

 Reflow [Ctrl + 4]. 

 Read Out Loud. 

 Save As Word or Accessible Text. 

 Add Tags Report. 

 Accessibility Full Check. 

 Bookmarks. 

 Action Wizard. 

Acrobat X has yet another complete redesign of the user interface. With each iteration of a new user 

interface we lose a lot of our ability to perform tasks easily using the keyboard. For example you can no 

longer press Alt + A, A, F to perform an Accessibility Full Check. You must show the Accessibility Panel to 

the right of the document, press F6 to put focus on it and arrow down until you find the tool you want, 

in this case the Accessibility Full Check. If the Accessibility Panel is not expanded, you will need to 

expand it using the Right Arrow key. 

Acrobat X cannot be integrated with a 64-bit version of Microsoft Office. If you are using a 64-bit version 

of Office and do not have the ability to uninstall it and install a 32-bit version your choices are to 

purchase a 32-bit version of Office to use with the Adobe add-in or to use the Save as PDF add-in from 

Microsoft for Office 2007 [a tool that is built into Office 2010]. 

Language 
The language of a document can be global or specific to content. This lets you establish the base 

language for content and then individual languages for specific pieces of content. As part of identifying 

an accessible PDF document, a base language has to be identified. This is done through the Advanced 

settings for Document Properties [Ctrl + D]. 
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Figure 8 Advanced tab in the Document Properties dialog showing a language choice. 

If you are converting a document from Microsoft Word 2007 or 2010 the default language of the 

document should come with it. However, it is always a good idea to check this. 

Tags Tree 
The Tags Tree is what adaptive technology uses to identify document structure and logical reading 

order. It is essential to have correct Tags and Tags in the right reading order. 

 

Figure 9 Tags Tree in Acrobat X. 

To show the Tags Tree in the Navigation Panel: 
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1. Press Alt + V, S for View, Show or Hide which opens another sub-menu. 

2. Navigation Panel should be the first item. Press the Right Arrow to expand this sub-menu. 

3. Choose Tags which will put the Tags Panel and the Tags Tree in the Navigation Panel to the left 

of the document. 

You will also want to add the Content and Order Panels to the Navigation Panel. 

To access the Navigation Panel: 

1. Pressing F4 will open and close the Navigation Panel. 

2. Pressing F6 will move focus from the document to the Navigation Panel and back in a cycle. 

3. You should be able to use the Up or Down Arrows to move through the tabs for Bookmarks, 

Content, Order and Tags and then press Tab to move into the specific panel. Once you Tab to 

the list of Tags, Bookmarks or order of pages you should be able to use the Up or Down Arrows 

to move from Tag to Tag or Bookmark to Bookmark and so forth; and use the Left and Right 

Arrows to expand or collapse a Tag or Bookmark. 

Highlight Content 
When Highlight Content is turned on it lets you perform several validation tasks at the same time. You 

can verify that all content is tagged, that the Tag is correct and that the content is in its logical reading 

order. Highlight Content does exactly what it says: as you select a Tag in the Tags Panel the 

corresponding content is highlighted in the tagged PDF document. 

  
Figure 10 Highlight Content in the Tags Tree Options. 

To turn on Highlight Content on the Tags Panel, activate the Options button and choose Highlight 

Content. This can also be done from the context menu anywhere in the Tags Tree. 
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Figure 11 Highlighted content in a tagged PDF document. 

Alt and Actual Text 
If there is an image or an object in a tagged PDF document that is not decorative, it needs to have either 

Alt Text or Actual Text. An image that is a photo or logo would require Alt Text or alternate text while an 

image of text such as a paragraph or image based heading would require Actual Text because what the 

attribute is rendering is actual document text rather than a description of an image. This choice affects 

how adaptive technology provides information to the person reading the document. 

 

Figure 12 TouchUp Properties dialog for Alt or Actual Text. 

Order Tab and TouchUp Reading Order Panel 

The Order tab gives you a snapshot of how content in the document has been tagged. However it 

cannot give you the more granular information that moving through the Tags Tree can. The Order panel 

is a good place to start so you can identify images without Alt Text, put decorative images into the 

background as Artifacts and switch to the TouchUp Reading Order tool to add any content that was not 

initially tagged that needs to be. 
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Figure 13 Order Panel open showing corresponding content in document. 

As you move through the page content, it is highlighted in the document. In the preceding image I’ve 

changed the default colours of document elements from black to very colourful so that they are easily 

identified. If content is out of order, drag it to its rightful position on a page. 

The following image shows the TouchUp Reading Order Panel which is a sort of extension of the Order 

Panel. The TouchUp Reading Order Panel can be activated through the Order tab or the Accessibility 

Panel to the right of the document. It floats over the document and there is no way to dock it anywhere. 

You just have to keep moving it out of your way or zoom out of the document and place it in the dark 

space around the document. In the image a component of the page has been selected which activates 

the buttons on the TouchUp Reading Order Panel. Document authors can customize the colours of page 

content so that it is easily identified. 

 

Figure 14 TouchUp Reading Order Panel floating over a PDF document. 

Find Tag From Selection and Create Tag from Selection 

To find a Tag from text or content selected in the PDF document, use the mouse to activate the Select 

Text tool [use the Select Object tool to select images or objects]. 

 

Figure 15 Select Text Tool. 

Activate the Options button in the Tags Panel and choose Find Tag from Selection. 
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Figure 16 Find Tag from Selection in Options menu. 

The Tag will be selected and expanded in the Tags Tree. 

Follow the same procedure to create a Tag from selected content but choose “Create Tag from 

Selection” instead of Find Tag from Selection.  Use the ability to highlight content to get as close to 

where you want the new content or Tag to be inserted into the Tags Tree. 

 

Figure 17 Create Tag from Selection in Options menu. 
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You can add content to an existing Tag or create a new Tag for content. If you need a new Tag for 

content the new Tag dialog will open for the newly created Tag. Choose the Tag type and continue the 

process 

 

Figure 18 New Tag dialog. 

Add or Edit Interactive Objects 
In the Content Panel to the right of the document are the tools that used to be called the “Advanced 

Editing Toolbar.” 

 

Figure 19 Add or Edit Interactive Content options from Content Panel to right of document. 

OCR Text Recognition [scanned documents] 
The ability to recognize text in scanned images of documents has changed since Acrobat 8. Although 

with Acrobat X there have been some refinements to the process, one of the issues that remain is an 

inability to make corrections if a word is not recognized properly and you are using the ClearScan option 

for recognition. ClearScan is the only option to make a document tagged PDF. 
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Figure 20 Image of document that requires OCR showing warning dialog. 

The preceding image is of a print brochure by Freedom Scientific who graciously agreed to let me use 

this for demonstration purposes. The content is available in accessible format. 

 

Figure 21 Recognize Text Panel to the right of the document. 

Once you choose to recognize text in the document, a dialog opens with an Edit button which is where 

you modify the settings for ClearScan. If you are creating a tagged PDF you must choose ClearScan as 

the method of recognizing text. Once you make this change it should stay in effect until you reinstall 

Acrobat or update Acrobat with a significant . 
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Figure 22 Recognize Text Settings. 

Reflow [Ctrl + 4] 
One of the tools available to document authors is the ability to reflow content on a page to demonstrate 

a logical reading order. Pressing Ctrl + 4 from the number row will reflow content that is in columns or in 

any way not displayed as a “single flow of text” so that document authors can visually inspect the 

reading order of content in the document. Note that table structures are not reflowed and if the 

document has form fields, this tool will not work. 

 

Figure 23 Document view before Reflow is turned on. 



20 
 

 

Figure 24 Document view after Reflow has been turned on. 

Pressing Ctrl + 4 again will return the document to its original layout. This is a method of viewing a 

reading order and does not affect the document itself.  Reflow will not work in a PDF form. 

Read Out Loud 
The Read Out Loud tool is a TTS or Text-to-Speech tool. It is not a screen reader. People reading a 

document with Read Out Loud can’t navigate a document in smaller pieces of information such as 

characters, words, lines or paragraphs. It is; however, a useful tool if a person’s adaptive technology is 

not available on a computer, if the person has visual or learning disabilities or if the person is 

experiencing visual fatigue from reading long PDF documents. Press Ctrl + Shift + Y to activate Read Out 

Loud, or choose View > Read Out Loud [it is now at the bottom of the View menu so pressing the Up 

Arrow once will move to Read Out Loud] 

In Acrobat X and Adobe Reader X, the Read Out Loud tool has to be activated before it can be used. This 

turns the tool on and lets the reader hear a bit more information from the document as they read 

through the text. 

 

Figure 25 Read Out Loud activation. 

Once activated, the document can be read in its entirety or page by page. To turn on the reading of form 

fields [if they’ve been made accessible], press Ctrl + K, choose Reading and check the Read form fields 

check box. 
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Save As Word Document or Accessible Text 
The ability to save a document as either a Word document or accessible text is sometimes used to verify 

the reading order of a document. It is more useful for people with disabilities who want to read the 

document outside of Acrobat or Reader. It takes time to save the document then go through it and 

validate it against the version in Acrobat. Depending on the timeframe of the task, this tool might be 

useful. 

 

Figure 26 Options to save tagged PDF as Word document. 

The preceding image shows the ability to save a tagged PDF as a Word document. This is found under 

File, Save As. The following image shows the ability to save a tagged PDF document as an accessible text 

format which is plain text. This is found under File, Save As, More Options. 

 

Figure 27 Save as accessible text option for tagged PDF. 

Add Tags Report. 
When you add Tags to an untagged PDF document, you will get an Add Tags Report that identifies what 

Acrobat suspects  are p with the tagging. If you create a tagged PDF from Office applications or other 

applications, there will not be an Add Tags Report. 
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Figure 28 Add Tags to a document from the Tags Tree. 

You can either add Tags to a PDF document from the Tags Panel as shown in the preceding image or 

through the Accessibility Panel to the right of the document shown in the following image. 

 

Figure 29 Add Tags to a PDF document from Accessibility Panel. 

When the Add Tags Report is generated an icon for it is placed just above the Tags icon. 

Use the Add Tags Report as a starting point to examine problem areas in the document. Then move to 

the Tags and Order Panels to begin making necessary repairs. 
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Figure 30 Add Tags report. 

As items are activated in the add Tags Report, they are highlighted in the document. This makes a quick 

review of the document easier. It also makes it easier to find the corresponding content in the Order or 

Tags Panels. 

Accessibility Full Check 
Performing an Accessibility Full Check periodically through the repair process is a good idea.  This will 

identify any outstanding issues in the document or any new issues that have arisen because of another 

repair.  A clean Accessibility Full Check does not mean that the document is accessible. 

 

Figure 31 Results of an Accessibility Full Check. 

When the full check is implemented, there are options that can be set to identify specific problem areas. 

It’s a good idea to leave the defaults and add anything else required by the audit process. 

The Accessibility Full Check is in the Accessibility Panel to the right of the document. 

Bookmarks 
One of the key elements of a tagged PDF document, and in fact any document, is a strong and accessible 

navigation structure. In Word and Excel documents a Table of Contents should be generated. If proper 

headings are used, this is an easy task. In turn, these headings can be converted to bookmarks in 

Acrobat. 
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Figure 32 Bookmarks in a tagged PDF document. 

One of the tools available for Bookmarks is the ability to make first level bookmarks a different colour so 

they are even easier to navigate.  

To add a Bookmark manually: 

1. Use the Select Text tool to select text. 

2. Use a right mouse click. 

3. Choose Add Bookmark. 

4. The Bookmark will be placed in the Bookmarks Panel. You may have to drag it to its logical point 

in the list of Bookmarks depending on where your focus was when the Bookmark was created. 

To make a Bookmark a different colour: 

1. Select the Bookmark. 

2. Press the AppKey and choose Properties. 

3. Change the colour of the Bookmark. 

4. Move to and activate the Close button. 

 

Figure 33 Bookmark Properties dialog. 
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Action Wizard 
Acrobat X has an "Action Wizard" to help automate some of the tasks. One of the tasks already set in the 

actions Wizard is "Accessible Document." This is not a complete set of steps and does not include the 

generation of links from web addresses or the inclusion of form controls. this also does not include OCR 

or the recognizing of text in scanned documents. 

 

Figure 34 Action Wizard in Acrobat X. 

It should also be noted that the dialogs for editing and creating new Action Wizard steps are not 

accessible if you are using a screen reader. 

 

Figure 35 Edit Action Wizard tasks. 
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